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Computer Vision Il - Lecture 2

Background Modeling

22.04.2014

Bastian Leibe
RWTH Aachen
http://www.vision.rwth-aachen.de

leibe@vision.rwth-aachen.de

Course Outline

¢ Single-Object Tracking

» Background modeling

» Template based tracking

» Color based tracking

» Contour based tracking
Tracking by online classification
Tracking-by-detection

v

v

¢ Bayesian Filtering
¢ Multi-Object Tracking

¢ Articulated Tracking

3

Image source: Tobias Jaegg|l
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Motivation: Tracking from Static Cameras

B. Leibe

Yideo source: Wolfgane Mehner
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Announcements

¢ Course webpage

» http://www.vision.rwth-aachen.de/teaching/
» Slides will be made available on the webpage

¢ L2P electronic repository
» Exercises and supplementary materials will be posted on the L2P

¢ Please subscribe to the lecture on the Campus system!
» Important to get email announcements and L2P access!
» Bachelor students please also subscribe

B. Leibe

Topics of This Lecture

¢ Motivation: Background Modeling

¢ Simple Background Models
» Background Subtraction
» Frame Differencing

« Statistical Background Models
» Single Gaussian
» Mixture of Gaussians
» Kernel Density Estimation

¢ Practical Issues and Extensions
» Background model update
» False detection suppression
» Shadow suppression

» Applications 5. Leibe 4

Motivation

¢ Goals

» Want to detect and track all kinds of objects in a wide variety
of surveillance scenarios.

= Need a general algorithm that works for many scenarios.

» Video frames come in at 30Hz. There is not much time to
process each image.

= Real-time algorithms need to be very simple.

¢ Assumptions
» The camera is static.
» Objects that move are important (people, vehicles, etc.).

¢ Basic Approach
» Maintain a model of the static background.
» Compare the current frame to this model to detect objects.

ide adapted from Rohert Collin LA
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Background Modelling Results Topics of This Lecture
o TR . i
¢ Simple Background Models
~ Background Subtraction
» Frame Differencing
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E| Ef
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B. Leibe Video source: Wolfgang Mehner B. Leibe
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Simple Background Subtraction Background Subtraction Results
M(t)

e Observation

» Background subtraction does a reasonable job of extracting the
object shape if the object intensity/color is sufficiently different
from the background.

¢ Procedure
» Background model is a static image (without any objects).

» Pixels are labeled based on thresholding the absolute intensity
difference between current frame and background.
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* What are the limitations of this simple procedure?

lide credit: Robert Collin B. Leibe ide credit: Robert Collin B. Leibe

RWTH ACHET
Background Subtraction: Limitations
e Outdated reference frame
» Objects that enter the scene and el .
stop continue to be detected...

...making it difficult to detect new
objects that pass in front of them.

RWTH/ACHEN
Background Subtraction: Limitations

¢ lllumination changes

» Background subtraction is sensitive §
to illumination changes and unim- §
portant scene motion (e.g., tree
branches swaying in the wind).

3 3

s s

: » If part of the assumed static back- 3 ¢ Global threshold

@ ground starts moving... @ » A single, global threshold for the

i ...both the object and its negative i entire scene is often suboptimal.

2 ghost (the revealed background) are 2

] 2}

> detected. >

£ =| = Need adaptive model with

o o ..

£ £ local decisions

o o ! 13
slide credit: Rohert Collin: B. Leibe ide credit: Robert Callin. B. Leibe




Simple Frame Differencing

; B
1w \ e M©

b
B(t-1) B

¢ Other idea
» Background model is replaced with the previous image.

Computer Vision Il, Summer’14

lide credit: Robert Collin B. Leibe

RWTH/ACHEN
Differencing and Temporal Scale

I(t) D(-1) D(-3) D(-5) D(-9) D(-15)

¢ More general formulation
» Define D(N) = ||1(t) - I{t+ N)|
o Effect of increasing the temporal scale

» More complete object silhouette, but two copies of the object
(one where it used to be, one where it is now).

Computer Vision Il, Summer’14

lide credit: Robert Collin B. Leibe
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Three-Frame Differencing
BN
& ™ 1 & 35
5 o 45
This worked well
for the person
.15 55

e Problem

» Choice of good frame-rate for three-frame differencing
depends on size and speed of object.
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lide credit: Rohert Collin 5. Lethe
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RWTHACHE
Frame Differencing Observations

¢ Advantages

» Frame differencing is very quick to adapt
to changes in lighting or camera motion.
Objects that stop are no longer detected.

Objects that start up no longer leave behind
ghosts.

v

v

¢ Limitations
» Frame differencing only detects the leading
and trailing edge of a uniformly colored
object.
» Very few pixels on the object are labeled.
» Very hard to detect an object moving
towards or away from the camera.

Slide credit: Robert Collin B. Leibe
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Three-Frame Differencing
¢ Improved approach to handle this problem
D(-15)
whedre ;he o!)t;igct was \/A.\'D ) N k
and where 1t 1s now \7_/ 3
where the object is now!
D(+15)
where the object is now
and where it will be
17
ide credit: Robert Collin: B. Leibe
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RWTH ACHET
Adaptive Background Subtraction
A
10 [ (‘%6[’;—’\:{; M(1)

a

» Current image is “blended” into the background model with «.
19

ide credit: Robert Collin LA




Adaptive Background Subtraction

¢ Properties
» More responsive to changes in illumination
and camera motion.
Small, fast-moving objects are well-segmented,
but they leave behind short “trails” of pixels.

v

v

Objects that stop and ghosts left behind by
objects that start both gradually fade into the
background.

The centers of large, slow-moving objects
start to fade into the background, too!
This can be fixed by decreasing the blend
parameter «, but then it takes longer for
ghost objects to disappear...

v

v
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lide credit: Robert Collin B. Leibe

RWTHACEN
Discussion

* Background subtraction / Frame differencing
» Very simple techniques, historically among the first.
» Straight-forward to implement, fast to test out.
» We’ve seen some fixes for the most pressing problems.

¢ Remaining limitations
» Rather heuristic approach.
» Leads to relatively poor foreground/background decisions.
» Optimal temporal scale still depends on object size and speed.
» Global threshold is often suboptimal for parts of the image.
= Very fiddly in practice, requires extensive parameter tuning.

Let’s try to come up with a better founded approach
» Using a statistical model of background probability...

Computer Vision Il, Summer’14

B. Leibe

Gaussian Background Model

o Statistical model

» Value of a pixel represents a measure- 7. N
ment of the radiance of the first object

intersected by the pixel’s optical ray.
» With a static background and static

lighting, this value will be a constant

affected by i.i.d. Gaussian noise.

¢ |dea

» Model the background distribution of each pixel by a single
Gaussian centered at the mean pixel value:

N B) = s o { 5= 08 -}

» Test if a newly observed pixel value has a high likelihood
under this Gaussian model.

= Automatic estimation of a sensitivity threshold for each pixel. ,,
B. Leibe
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Slide adapted from Robert Collin B. Leibe
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Topics of This Lecture
B o Statistical Background Models
% » Single Gaussian
E » Mixture of Gaussians
'?’_ » Kernel Density Estimation
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Recap: Maximum Likelihood Approach

¢ Computation of the likelihood
» Single data point: p(In‘g)

» Assumption: all data points X = {x1,...,,} are independent

N
L(O) =p(X]0) = [] p(xal0)
» Log-likelihood n=1.\
E(f) =~ L(#) = — Y Inp(z./9)

n=1
¢ Estimation of the parameters ¢ (Learning)
» Maximize the likelihood (=minimize the negative log-likelihood)
= Take the derivative and set it to zero.
N o

7] Zp(x,|0)

—E(0) = — 20 L

00 ( ’LZ::I p(xn]0)

ide credit: Bernt Schiele B. Leibe
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RWTH/CET
Recap: Maximum Likelihood Approach

¢ For a 1D Gaussian, we thus obtain
N
. 1
M= N Z Tn
n=1
¢ In a similar fashion, we get
1 N
~2 ~\2

o 0=(j1,6) is the Maximum Likelihood estimate for the
parameters of a Gaussian distribution.

* Note: the estimate of the sample variance is biased.
Better use 1 X
-2 g )
N1 > (@n—p)

n=1
B. Leibe

“sample mean”

“sample variance”

RWTH CHE
Problem: Complex Distributions

RG scatter plots of the same pixel taken 2 min apart

Bi-modal distribution caused by specularities on the water surface

= A single Gaussian is clearly insufficient here...

B. Leibe

28
Image source: Chris Stauffel
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RWTH ACHET
MoG Background Model
¢ Improved statistical model
» Large jumps between different pixel values ' ()
because different objects are projected onto
the same pixel at different times. 05

» While the same object is projected onto the
pixel, small local intensity variations due to | 05
Gaussian noise.

¢ |dea
» Model the color distribution of each pixel by a mixture of K
Gaussians i

p(x) =3 MmN (g )
k=1
» Evaluate likelihoods of observed pixel values under this model.
> Or let entire Gaussian components adapt to foreground objects
and classify components as belonging to object or background. i
B. Leibe

lmage source: Chris Bischoj
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RWTH/CET
Online Adaptation (1D Case)

¢ Once estimated, adapt the Gaussians over time
» We can compute a running estimate over a time window

1 1 -
A1) _ a0 (t+1) (t+1-T)
1 I — T
¢ F N N
(z(t+)) _ ft+1)y2

F2)(t+1) — (52)(t)
(%) @ + 5

1 T .
L (gD ity
N-1

» However, distribution is non-stationary (and newer values are
more important) = better use Exponential Moving Average filter

D = (1 - a)a® + ez
()00 = (1 — a)(F2) V) + a2+ — l+1)?

with a fixed learning rate a.

B. Leibe
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Problem: Adaptation Speed, Sensitivity

¢ If the background model adapts too slowly...

» Will construct a very wide and inaccurate model with low
detection sensitivity

« If the model adapts too quickly...
» Leads to inaccurate estimation of the model parameters

» The model may adapt to the targets themselves (especially
slow-moving ones)

¢ Design trade-off

» Model should adapt quickly to changes in the background
process and detect objects with high sensitivity.
» How can we achieve that?

B. Leibe
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Recap: Mixture of Gaussians

K
plx) =3 meN (%0, )

k=1

¢ “Generative model”

31
Image source: C.M, Bishop, 200

ide credit: Bernt Schiele B. Leibe




Recap: EM Algorithm

¢ Expectation-Maximization (EM) Algorithm
» E-Step: softly assign samples to mixture components
NGl 3)
D=1 TN (g Zi)
» M-Step: re-estimate the parameters (separately for each mixture
component) based on the soft assignments

i (Xn) vj=1,....,K, n=1,...,N

= N
bt
E Nj « Z 7;(%n) = soft number of samples labeled j
E| n=1
5 N
é -
: T
@ N
2 1
- new
E By —A—Z'yj(xn)xn
2 Jn=1
5
E $new 1 + new ~new\T
3 B Ny () (3 — ) (6 — )
- N = N
slide adapted from Bernt Schiele B. Leibe

Stauffer-Grimson Background Model

¢ |dea
» Model the distribution of each pixel by a mixture of K Gaussians

i
plx) = ZTFA:-V(X:JM,-.:- Zi) where I, =il

k=1
Check every new pixel value against the existing K components
until a match is found (pixel value within 2.5 o, of ;).
If a match is found, adapt the corresponding component.
Else, replace the least probable component by a distribution
with the new value as its mean and an initially high variance and
low prior weight.
Order the components by the value of w, /o, and select the best
B components as the background model, where

b
. Wy,
B=¢ g —>T
dl"nglbl]l ( - )

k=1 7%

v

v

v

v

Computer Vision I, Summer’14

34

RWTHAACHER
Discussion: Stauffer-Grimson Model

¢ Properties
» Static foreground objects can be integrated into the mixture
- Advantage: This doesn’t destroy the existing background model.

- If an object is stationary for some time and then moves again, the
distribution for the background still exists

= Quick recovery from such situations.

- Ordering of components by w;/o;,
- Favors components that have more evidence (higher w,)
and a smaller variance (lower o;).
= Those are typically the best candidates for background.

> Model can adapt to the complexity of the observed distribution.

- If the distribution is unimodal, only a single component will be
selected for the background.

= This can be used to save memory and computation.
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B. Leibe

RWTHAACHE

¢ Very popular model
» Used in many tracking approaches
» Suitable for long-term observations (finding patterns of activity)

Computer Vision Il, Summer’14

C. Stauffer, W.E.L. Grimson, Adaptive Background Mixture Models for
Real-Time Tracking, CVPR 1998.
B. Leibe

Image source: C, Stauffer

RWTH CHE
Stauffer-Grimson Background Model

¢ Online adaptation

» Instead of estimating the MoG using EM, use a simpler online
adaptation, assigning each new value only to the matching
component.

» Let M;, = 1 iff component £ is the model that matched, else 0.

‘r+l] =(1- (}‘)ﬂ’(‘j} + oMy,

» Adapt only the parameters for the matching component
1+1 3
,ui d=(1- ;))uﬁj + pzlt+l)
1 ) 1 + T
B = (12 Bl 4 p(at ) = Tl YT
where
p = N (%l e, )
(i.e., the update is weighted by the component likelihood)

(
T

Computer Vision Il, Summer’14

B. Leibe

Problem: Outdoor Scenes

200 v T T 4 T 4 v

150

|
I W e \ '*””K\q
Ay

gray value

51

300 400 5 600

800 Q00

Dynamic areas
» Waving trees, rippling water, ...
» Fast variations

= More flexible representation
needed here.
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B. Leibe lmage & Video source: A, Eleammal
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RWTHACHE
Recap: Kernel Density Estimation

¢ Estimating the probability density from discrete samples

» Approximation: p(x) ~ W

fixed V fixed K
determine K determine V

Kernel Methods  K-Nearest Neighbor

¢ Kernel methods
» Example: Determine -
the number K of data = -
points inside a fixed -
hypercube... .

Computer Vision Il, Summer’14

Slide credit: Bernt Schiele B. Leibe

Recap: Parzen Window

¢ Interpretations
1. We place a kernel window k at
location x and count how many
data points fall inside it.

2. We place a kernel window k around
each data point x, and sum up
their influences at location x.

= Direct visualization of the density.

¢ Still, we have artificial discontinuities at the cube
boundaries...

» We can obtain a smoother density model if we choose a
smoother kernel function, e.g. a Gaussian

Computer Vision Il, Summer’14

40
B. Leibe

Kernel Background Modeling
¢ Nonparametric density estimation

» Estimate a pixel’s background distribution using the kernel
density estimator K(-) as

N
1 - i
p(xt) = v E K(x® - x
=1

- Choose K to be a Gaussian (0, ) with = = diag{c }. Then
1 N o d 1 _l“‘:”- )2
2 p
P(X(”)=$ZH ——¢ )
=1 =1 V'QWUf

» A pixel is considered foreground if p(x()) < 6 for a threshold 6.
- This can be computed very fast using lookup tables for the kernel
function values, since all inputs are discrete values.
- Additional speedup: partial evaluation of the sum usually sufficient
a2

B. Leibe
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RWTHACHE
Recap: Kernel Density Estimation

¢ Parzen Window
» Hypercube of dimension D with edge length h:

(1 e L oi=1,....D [
k(u)—{ 0, else

“Kernel function”

=
E Yoox-x
& _
£ K=> k(=) V= [k(udu=h
a h
= n=1
c
-,s% » Probability density estimate:
> N
5 K 1 X — X,
Z P(X) R o = oy O k(——)
£ NV Nh h
3 n=1
39
Slide credit: Bernt Schiele B. Leibe
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Kernel Background Modeling

¢ Nonparametric model of background appearance

» Very flexible approach, can deal with large amounts of
background motion and scene clutter

A. Elgammal, D. Harwood, L.S. Davis, Non-parametric Model for
Background Subtraction, ECCV 2000.

Computer Vision Il, Summer’14

41
B. Leibe Video source: Ahmed Elgammal

Results Kernel Background Modeling

¢ Performance in heavy rain

<
=
i
o
£
=
3
@
=
&
=
b
s
2
5
2
E
o
o

) 44
B. Leibe Yideo source: Abmed Elgammal



http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf

Results Kernel Background Modeling

¢ Results for color images

¢ Practical issues with color images
» Which color space to use?

Computer Vision Il, Summer’14

4
B. Leibe Video source: Ahmed Elgammal

RWTH CHE
Practical Issues: Background Model Update

+ Kernel background model
» Sample N intensity values taken over a window of W frames.

¢ FIFO update mechanism
» Discard oldest sample.

» Choose new sample randomly from each interval of length
W/ N frames.

¢ When should we update the distribution?

» Selective update: add new sample only if it is classified as a
background sample

» Blind update: always add the new sample to the model.

Computer Vision Il, Summer’14
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B. Leibe

RWTH ACHET
Solution: Combining the Two Models

¢ Short-term model

Recent model, adapts to changes quickly to allow very sensitive
detection

Consists of the most recent NV background sample values.

Updated using a selective update mechanism based on the
detection mask from the final combination result.

v

¢ Long-term model

» Captures a more stable representation of the scene background
and adapts to changes slowly.

» Consists of N samples taken from a much larger time window.
» Updated using a blind update mechanism.

¢ Combination
» Intersection of the two model outputs.
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49
B. Leibe [A. Elgammal, D, Harwood, |, Davis, ECCv’00]
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Topics of This Lecture

¢ Practical Issues and Extensions
» Background model update
» False detection suppression
» Shadow suppression
» Applications 5. Leibe 46
RWTH CHE

Updating Strategies

¢ Selective update
» Add new sample only if it is classified as a background sample.

» Enhances detection of new objects, since the background model
remains uncontaminated.

» But: Any incorrect detection decision will result in persistent
incorrect detections later.

= Deadlock situation.

¢ Blind update
» Always add the new sample to the model.
~ Does not suffer from deadlock situations, since it does not
involve any update decisions.
» But: Allows intensity values that do not belong to the
background to be added to the model.
= Leads to bad detection of the targets (more false negatives).

48
B. Leibe
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RWTH ACHET
Extension: False Detection Suppression

¢ Problem

» Small camera motion (e.g., due to wind swaying) may still result
in false detections.

e Workaround

-~ Consider a small circular neighborhood (e.g., 5x5) Ne(x) and
evaluate the pixel under each neighbor’s background model B,:

o (x(B)y — (t)

o(x = max x'""|B

pre(x'") yFM[ij( y)

» Threshold py, to determine the foreground pixels.

= Eliminates many false detections, but also some true ones.

» To avoid losing true detections, add the constraint that an entire
connected component must have moved from a nearby location,
not only some of its pixels.

50
B. Leibe JA. Elgammal, D, Harwood, |, Davis, ECCv'00]




Extension: Shadow Suppression

Original video Without false With false
detection suppr. detection suppr. « Shadows are often detected together with the objects
» Leads to poor localization, should be avoided.
« Results » ldea: Shadowed regions should have the same color as the

neighboring background, only the intensity is lower.

» Effects of camera wind shaking are almost entirely suppressed = Use chromaticity coordinates to remove shadows.

Computer Vision Il, Summer’14
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B. Leibe

5
Video source: Ahmed Elgamma B. Leibe

RWTH CHE RWTH CHE
Color Normalization Chromaticity Coordinates
¢ One component of the 3D color space is intensity ¢ Observation:
» If a color vector is multiplied by a scalar, the intensity changes, » Since R + G + B =1, only 2 parameters are necessary
but not the color itself. » E.g.,one canuse R and G and obtains B=1-R-G
» This means colors can be normalized by the intensity. G
- Intensity isgivenby I = R + G + B: A~
~ »Ch ti tation* _
< romatic representation < . R+G+B=1
g R G g / ’
£ r= g= £ R
a R+G+B R+G+B a
= = i /0 .
s B = i
b= D B
> R+G+B >
£ g » Caveat: cannot distinguish between white and gray anymore!
g g = Use the normalized (r,g) coordinates, but keep the lightness
8 3 s = R + B + G as third coordinate = (r,g,s)
B. Leibe 3 B. Leibe 54
RWTH ACHET
Shadow Removal Procedure Effect of Shadow Suppression
¢ |dea

» Let <r, g, s> be the expected background pixel color
and <r;, g;, 5,> be the observed one.

~ Shadows or highlights affect the expected pixel lightness within
certain bounds a < s,/s < 3.

8 ¢ Procedure b
E » Select the subset B of relevant sample points for each pixel E
E from the stored set A, i.e. those samples that could produce the El
@ observed lightness if affected by shadows: @
< 5
2 B= {.T.,ll:; cAna<t< 3} 2
$ £
& ; o
3 > Apply the regular kernel background model based on this subset Z Original video Without shadow suppr.  With shadow suppr.
: B using only the (r,g) color components. £
o o
55 . 56
B. Leibe A Eleammal, D Harwood, L, Davis, ECCV'00] B. Leibe lideo source: Ahmed Elgammal
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Topics of This Lecture

¢ Practical Issues and Extensions
» Background model update
» False detection suppression
» Shadow suppression

» Applications B. Leibe

Applications: Articulated Tracking

¢ Background modeling as preprocessing step
» Track a person’s location through the scene
» Extract silhouette information from the foreground mask.
» Perform body pose estimation based on this mask.

B. Leibe

59
Video source: Hedvik Kj Tobias Jaeggl

<
T
L
o
=
=
>
a
s
o
i
b
o
o
5
2
E
3
o

References and Further Reading

¢ More information on density estimation in Bishop’s book
» Gaussian distribution and ML:  Ch. 1.2.4 and 2.3.1-2.3.4.

» Mixture of Gaussians: Ch. 2.3.9and 9
> Nonparametric methods: Ch. 2.5.

¢ More information on background modeling:
» Visual Analysis of Humans: Ch. 3

» C. Stauffer et al., Adaptive Background Models for Real-Time Tracking, CVPR’98
~ A. Elgammal et al., Non-parametric Model for Background Subtraction, ECCV’00

Christopher M. Bishop
Pattern Recognition and Machine Learning
Springer, 2006

Visual Analysis
of Humans

T. Moeslund, A. Hilton, V. Krueger, L. Sigal
Visual Analysis of Humans: Looking at People
Springer, 2011

B. Leibe

RWTHACHEN
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RWTH/CET
Applications: Visual Surveillance

Y
« Background modeling to detect objects for tracking
» Extension: Learning a foreground model for each object.

58
B. Leibe Video source: lan Reid, Univ. of Oxfor

Summary

¢ Background Modeling

» Fast and simple procedure to detect moving object in static
camera footage.

» Makes subsequent tracking much easier!
= If applicable, always make use of this information source!

¢ We’ve looked at two models in detail
» Adaptive MoG model (Stauffer-Grimson model)
» Kernel background model (Elgammal et al.)
» Both perform well in practice, have been used extensively.

¢ Many extensions available
» Learning object-specific foreground color models
» Background modeling for moving cameras

B. Leibe
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http://www.cs.umd.edu/users/elgammal/docs/bgmodel_ECCV00_postfinal.pdf
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